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Chapter 1

Introduction

This tutorial describes how to use ISim Hardware co-simulation to accelerate the
simulation of Floating Point Unit (FPU) Fast Fourier Transform (FFT) and verify the FFT
implementation on a Xilinx® ML605 board.

Digital Signal Processing (DSP) designs are typically very time-consuming to simulate in
software due to their data and computation intensiveness.

* A fast, bit-accurate model is often used to speed up the simulation of a DSP function,
but it does not provide any cycle accuracy and is not straightforward to integrate
with other Register Transfer Level (RTL) modules.

* A behavioral RTL model provides bit-and-cycle accuracy but is relatively slower
to simulate. A structural Register Transfer Level (RTL) or gate-level model is even
much slower to simulate.

* Sometimes an IP does not provide a fast, bit-accurate model or even a behavioral
RTL model, which leaves the slowest structural/gate-level simulation as the only
choice.

ISim hardware co-simulation provides an additional means to simulate DSP functions
by offloading intensive computations to FPGA. It can bring synthesizable HDL code,
synthesized or protected netlists such as IP cores generated by CORE Generator™
software into FPGA for co-simulation. That solves the problem of getting bit-and-cycle
accurate simulation models as well as bolstering the simulation performance. For many
complex DSP designs, not only does it accelerate the simulation of a design, it verifies
the implementation of the design on actual hardware. ISim hardware co-simulation
complements RTL, post-synthesis, and post-implementation simulation to complete
the verification tool suite.

Prerequisites

¢ ISE® Design Suite
e Virtex®-6 FPGA ML605 Evaluation Kit
e Design File: rdf0125_fft sim_tutorial.zip

Accelerating Floating Point FFT Simulation
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Tutorial Files

File Description

fp_fft_top.v Wrapper that instantiates the floating point FFT core.

fp_fft_tb.v Top-level Verilog testbench that generates test vectors to exercise
the FFT core.

fp_fft_tb.vhd Top-level HDL testbench that generates test vectors to exercise
the FFT core.

FloatingPointFFT.xise ISE® project for this tutorial.

sim.tcl Custom simulation command file that measures the ISim
simulation time.

fp_fft_tb.wcfg Custom waveform configuration file.

fp_fft_tb.prj ISim project file for the command line flow.

full_compile.bat Windows batch file to fully compile the design for hardware
co-simulation with the Fuse command line.

full_compile.sh Linux shell script to fully compile the design for hardware
co-simulation with the Fuse command line.

incr_compile.bat Windows batch file to incrementally compile the testbench for
hardware co-simulation with the Fuse command line.

incr_compile.sh Linux shell script to incrementally compile the testbench for
hardware co-simulation with the Fuse command line.

run_isim.bat Windows batch file to launch the ISim simulation.

run_isim.sh Linux shell script to launch the ISim simulation.

Note When performing this tutorial, all data files must be copied to your current
working directory.
Accelerating Floating Point FFT Simulation
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Chapter 2

Tutorial

This tutorial describes how to use ISim Hardware Co-simulation to accelerate the
simulation of Floating Point Unit (PFU) Fast Fourier Transform (FFT) and verify the FFT
implementation on a Xilinx® ML605 board.

This tutorial has four sections with the steps you need to perform to run an FFT design
through ISim hardware co-simulation. Perform the steps in the order that they are
presented. These sections are as follows.

1. Generating a FFT Core in CORE Generator™

2. Creating a Test Bench

3. Compiling the Design for Hardware Co-Simulation
4

Running ISim Hardware Co-Simulation

Step 1. Generating a FFT Core in CORE Generator

In this tutorial, you use the Fast Fourier Transform (FFT) IP core in the CORE
Generator™ tool and create an ISim Hardware Co-Simulation (HWCoSim) testbench
that runs on the Virtex®-6 FPGA ML605 Evaluation Kit.

Note The screen captures in this tutorial are based on the Fast Fourier Transform
version 8.0. The CORE Generator GUI might look different in later versions of the tool.

1. Launch the ISE® Project Navigator.

2. Select File > New Project to open the New Project Wizard. Enter a project name
(FloatingPointFFT ) and location. Click Next.

Accelerating Floating Point FFT Simulation
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& New Project Wizard

Create New Project
Specify project location and type.
Enter a name, locations, and comment for the project
MName: FloatingPointFFT
C:\Tutorials\DSP\FloatingPointFFT

Location:

Waorking Directory: | C:VTutorials\DSP\FloatingPointFFT

E1E)

Description:

Select the type of top-evel source for the project

Top-evel source type:

HDL

[=]

vt ] [ e

3. On the Project Settings page:

® Choose the part for the ML605 board, which is a Virtex®-6 device XC6VLX240T

* Set the package to FF1156
* Set the speed to -1

* Select ISim as the simulator and Verilog as the preferred language.

e (lick Next and then Finish to complete the project creation.

www.Xilinx.com
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(=]
@ & MNew Project Wizard

Project Settings

Specify device and project properties.

Select the device and design flow for the project
Property Mame Value
Evaluation Development Board Virtex 6 MLB05 Evaluation Platform |Z|
Product Cateqory Al
Family Virtext
Device ACEVLK240T
Package FF1156
Speed -1
Top-Level Source Type HDL
Synthesizs Tool XST (WHDL/Verilog) |Z|
Simulator 1Sim (VHDL/ Verilog) |Z|
Preferred Language Verilog |Z|
Property Specification in Project File | Store all values |Z|
Manual Compile Order =]
VHDL Source Analysis Standard VYHDL-93 |Z|
Enable Message Filtering ]

) o)

4. Choose Project > New Source to open the New Source Wizard. Select IP (CORE
Generator & Architecture Wizard) and name the IP as fp_fft_core . Click Next.

[=]

o New Source Wizard

Select Source Type

Select source type, file name and its location.

L7 IP (CORE Generator & Architecture Wizard)
Schematic

User Document

Verilog Module

] Verilog Test Fixture

g VHOL Module .
[Py VHDL Library File: name:
[¢] VHDL Package fp_fft_core
g WHDL Test Bench )
E Embedded Processor Location:

C:\Tutorials\DSP \FloatingPointFFTYipcore_dir E]

Add to project

) o)

5. Select Fast Fourier Transform version 8.0 from the IP list (either By Function or By
Name). Click Next, and then click Finish.

Accelerating Floating Point FFT Simulation
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@ & New Source Wizard

Select IP

Create Coregen or Architecture Wizard IP Core.

View by Function View by Name

Name | <
’q FIR Compiler
B[~ Transforms
& |7 DFTs !
’q Discrete Fourier Transform
B |57 FFTs

[ Fast Fourier Transform

4 xilin.comeipaeffed .0

=77 Clocking 52
Search IP Catalog: |F ” Clear
[ all 1P versions ] only IP compatible with chosen part

I Next I [ Cancel ]

6. When the FFT core GUI opens, set the Transform Length to 16384. Select Pipelined,
Streaming I/O as the implementation, and click Next.

%{ Fast Fourier Transform EI@
Documents  View
TP Symbol & X

19iC 7 Fast Fourier Transform

xilinx.com:ip:xfft:8.0

Component Name |fp_fft_cure

5_axis_config_tdata[15:0] Channels Transform Length

5_zds_config tesid 16384 -

= _ais_config_tready
Implementation Options

Target Clock Frequency FE Range: 1..550 MHz
m_adis_data_tdsta[31:0] ) Automatically Select

Target Data Throughput Range: 1..550 MSPS

@ Pipelined, Streaming /O

s_axis_data_tdata[31:0]
s_aods,_data_tvalid i
5_axis_dats_tlast m_sxis_data_tvalid

= =xis_data_tresdy m_axis_data_tlast

m_axis_data_tready ©) Radix-4, Burst /O

) Radix-2, Burst /'O

@ Radix-2 Lite, Burst yO
event_frame_started

event_tlast_unexpected
event_tlast_missing Run Time Configurable Transform Length

Transform Length Options

> evant_fft_overfia
event_data in_channal_hak
‘event_status_channel_hait

event_data_out_channel_halt

< | ] ] »
% TP symbol |Q Implementation Details | % Latency | % CModels ‘ SlBack | o [ Hexto, ] I Ganerate I [ Cancel ] I Help ]

7. Set the Data Format to Floating Point, and the Output Ordering to Natural Order.
Click Next.

Accelerating Floating Point FFT Simulation
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] Fast Fourier Transferm
Documents  View
TP Symbol & X

s_axds_config_tdata15:0]

s_axis_config_tvalid

_aods_ponfig_tready

s_axis_dala_tdata[63.0]
5_axis_data_tvaid
3_sxis_data_tlast
=_xis_data_tiesdy

event_data_in_channel_halt
event_status_channel_hait

event_data_out_channel_halt

< i ] v

4 TP symbol |Q Implementation Details | % Latency I % CModels

8. Choose Use 4-multiplier structure (performance optimization) for the Complex

lgiC\**  Fast Fourier Transform

Data Format
) Fixed Point @ Floating Point
Precision Options

Input Data Width (32 -

Phase Factor Width

Scaling Options Rounding Modes

Unscaled _
@ Truncation
@ Scaled

Block Floating Point

Control Signals Output Ordering
[] ACLKEN
[C] ARESETn (active low)

ARESETn must be asserted for a minimum of 2
cycles

@ Natural Order

Optional Output Fields Throttle Schemes

Convergent Rounding

() Bit/Digit Reversed Order

Cyclic Prefix Insertion

[==]=]

xilime.com:ip:xfft:8.0

[T XK_INDEX ) Real Time
[T ovFLO @ Non Real Time
[ < Back IPEgeZof3l Mext > HGenerateH Cancel H Help

Multipliers option. Click Generate to generate the core.

Q’ Fast Fourier Transform
Documents ~ View

IP Symbol 8 x

s_ais_config_tdata[15:0]
=_axis_config_tvalid

5_xis_config_tready

5_axis_data_tlast m_axis_data_tvalid

=_axis_dats_tready. m_sxis_dats_tiast

m_axis_data_tesdy

event_frame_startad
event_tlast_unexpected

event_tlast_missing

3 event_fit_overfio
event_data_in_channel_halt
event_status_channel_halt

event_data_out_channel_hait

< . +

4 1P symbol ‘ %] Implementation Details | ] Latency | 4 CModels

9. Add a top-level module, fp_fft_top

fp_fft_core

logiCFE Fast Fourier Transform
Memory Options
Data Phase Factors
@ Block RAM @ Block RAM

Distributed RAM Distributed RAM

Number Of Stages Using Block RAM Reorder Buffer

- @ Block RAM
7 -
Distributed RAM
Hybrid Memaries

[] Optimize Block RAM Count Using Hybrid Memories

Optimize Options
Complex Multipliers
(©) Use CLB logic

(©) Use 3-multiplier structure (resource optimization)

@ Use 4-multiplier structure (performance optimization)

Butterfly Arithmetic
@ Use CLB logic

() Use XtremeDSP Slices

===

xilinx.com:ip:xfft:8.0

Page 3of 3 | MNext>

[ Generate ] [ Cancel I [ Help

, that instantiates the generated
IP core. This is required because ISim hardware co-simulation only

supports a Hardware Definition Language (HDL) top-level module. You can use the

completed fp_fft_top.v

> fp_fft_top.v, select Open and then click OK.

provided in this tutorial. Choose Project > Add Source

Accelerating Floating Point FFT Simulation
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Step 2: Creating a Testbenc h

1. Add a Verilog testbench module fp_fft_tb.v that generates test vectors to
exercise the fp_fft_top instance. You can use the completed fp_fft_tb.v file
provided in this tutorial.

2. Select Project > Add Source > fp_f£ft_tb.v.
3. Click Open, and then click OK.

The testbench has two 64-bit by 16384 arrays fft_xn_re_data ,fit xn_im_data , for
storing the real and imaginary components of the FFT input.

When the simulation starts, the testbench loads the FFT input vector from the
input_data.txt data file, for the first frame.

The input_data.txt file stores one data point per line. Each data point compromises
two 32-bit hexadecimal values, the real and imaginary, respectively, separated by a
space. The hexadecimal values are the binary representation of the floating point
numbers using the IEEE 754 standard.

Note The TXT data files must be in the directory from which the simulation is being run.

The operations performed by the demonstration testbench are appropriate for the
configuration of the generated core, and are a subset of the following operations:

¢ Frame 1: Drive a frame of pre-generated input data from the file.

¢ Frame 2: Configure an inverse transform; drive the output of Frame 1 as a frame
of input data.

¢ Configure Frame 3: A forward transform while the previous transform is running.

* Frame 3: Drive the output of Frame 2 as a frame of input data; de-assert AXI TVALID
(and TREADY if present) signals occasionally to demonstrate AXI handshaking

¢ Frames 4-7: Run these frames back-to-back, as quickly as possible:

- Queue up configurations for a forward transform (Frame 4) followed by a
reverse transform (Frame 5), both with a smaller point size (if the point size is
configurable) and a short cyclic prefix (if available).

—  Frame 4: Drive a frame of pre-generated input data.

— Frame 5: Drive the output of Frame 1 as a frame of input data; simultaneously
configure Frame 6: A forward transform with maximum point size, a longer
cyclic prefix (if available) and a zero scaling schedule (if fixed scaling is used).

—  Frame 6: Drive a frame of pre-generated input data; simultaneously configure
Frame 7: An inverse transform with maximum point size, no cyclic prefix and
default scaling schedule (if fixed scaling is used)

— Frame 7: drive the output of frame 1 as a frame of input data.

*  Wait until all frames are complete.

Accelerating Floating Point FFT Simulation
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Step 3: Compiling the Design for Hardware Co-Simulation

After you create the testbench, you can compile the design for hardware co-simulation
using the ISim compiler. This can be done in Project Navigator by enabling hardware
co-simulation on a selected instance in your design. The selected instance, including its
sub-modules, are co-simulated in hardware during the ISim simulation. Other modules

are simulated in software.

1. In Project Navigator, switch to the Simulation View. From the Hierarchy Pane,

right-click the fp_fft_top

instance, and click Source Properties.

o I5E Project Navigator (0.76) - C:\Tutorials\DSP\FloatingPointFFT\FloatingPointFFT.xise - [Design Summary]
L File Edit View Project Source Process Tools  Window

REEAS Y ) Xoo| »iprpR 2RIREEILRIPELT
Design 0 & x| , | = Design Overview
h
[ | view: ©) {8 tmplementation @[3 smulation — B S:lmmary
O [] 10B Properties
G.E_l Behavioral E| O ] Module Level Utilization
L1 | Hierarchy [ Timing Constraints
g_j 'C‘ﬂ FloatingPointFFT c_) O Iimc_ut Report
5 | 5 £ xcHvba40t-1f1156 - [ Clock Report
—— e th (fp_fft_thv) ld C:‘ Static Timing
% =) dut - fp_fft_top (fatteton ?E [=- Errars and Warnings
4y fft-fp_fftcq [[| Mew Source... = % pa'i:'MESSEQES
— Synthesis <
£ Add Source... ﬁ | Translation
— gﬂ Add Copy of Source... Ma ssages
[ Place and Route Messages
Open [ Timing Messages
El e [ Bitgen M 3
[E] All Implementation Messages
Manual Compile Order = DEtEEd Reports
o - Synthesis Report
sy SetasTop Module [ Translation Report
SmartGuide... O] Map Report
. . [ Place and Route Report
13
¥ | F) No Processes Running ey D Post-PAR Static Timing Report
— Power Report
Expand All ] P
Iij'{: Processes: dut - fp_fft_top [Z=Ir D Bitgen Report
‘E"{: E $ 15im Sirnulator Lol Secondary Reports
b 2  Behavioral Check
Zf B  Simulate Behavig () Ao Ctrl+F
— - - - Design Properties
T i [] Enable Message Filtering
Source Properties... Optienal Design Summary Contents
[] Show Clock Report
[] Show Failing Constraints
[] Show Warnings
[] Show Errors
& Start | B Design luj Files |E Libraries - 1SE Design Suite InfoCenter

2. In the Source Properties dialog box, do the following:

® Select the Hardware Co-Simulation category.

e Check the Enable Hardware Co-Simulation check box.

e Set the Clock Port to aclk.

* Select ML605 (JTAG) as the target board.

* Leave the Enable Incremental Implementation option unchecked, and Click

OK.

Note The enabled instance for hardware co-simulation is now marked with a

special icon.

Accelerating Floating Point FFT Simulation
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Compiling

You can use the Enable Incremental Implementation option after the design

is compiled for hardware co-simulation. If the instance selected for hardware
co-simulation does not change in subsequent runs, you can turn on this option
to skip the synthesis, implementation, and bitstream generation for hardware
co-simulation. It allows the testbench or any portion simulated in software to be
modified and simulated again quickly.

3. From the Hierarchy Pane, select the fp_fft_tb instance.

4. In the Process Pane, right-click Simulate Behavioral Model and click Process
Properties.

5. In the Process Properties > ISim Properties dialog box, change the Property display
level to Advanced, and click OK. Review the values; this tutorial uses the default
Advanced settings. Click OK.

6. In the Process Pane, run the Simulate Behavioral Model process for the dut -
fp_fft_tb instance.

the Design on the Command Line

You can invoke the ISim compiler through the Fuse command line tool. You must
provide a project file, the design top level module(s), and other optional arguments such
as libraries and library search path to which to link. To compile the design for hardware
co-simulation, you must also provide the following arguments:

fuse -prj <project file> <top-level modules>
-hwcosim_instance <instance>
-hwcosim_clock <clock>
-hwcosim_board  <board>

-hwcosim_constraints <constraints file>
-hwcosim_incremental [0]1]
e -hwcosim_instance : Specifies the full hierarchical path of the instance to

co-simulate.
e -hwcosim_clock : Specifies the port name of the clock input for the instance.
—  This is the clock in the lock-step portion, that is to be controlled by the testbench.

- For a design with multiple clocks, specify the fastest clock using this option so
that ISim can optimize the simulation. Other clock ports are treated as regular
data ports.

e -hwcosim_board : Specifies the identifier of the hardware board to use for
co-simulation.

* -hwcosim_constraints (optional): Specifies the custom constraints file that
provides additional constraints for implementing the instance for hardware
co-simulation. We also use the constraints file to specify which ports of the instance
are mapped to external I/Os or clocks.

e -hwcosim_incremental (optional): Specifies whether Fuse should reuse the last
generated hardware co-simulation bitstream and skip the implementation flow.

For example, to compile the FFT design for this tutorial, you can run the Fuse command
line as follows:

fuse -prj fp_fft_tb.prj fp_fft_tb
—o fp_fft_tb.exe
-hwcosim_instance [fp_fft_th/dut

-hwcosim_clock aclk
-hwcosim_board  ml605-jtag

14
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Step 4: Running I1Sim Hardware Co-Simulation

The simulation executable generated by the compiler runs in the same way in both
software simulation and hardware co-simulation flow. Project Navigator automatically
launches the simulation executable in GUI mode after the compilation finishes.

In the Instances and Processes Pane, the instance selected for hardware co-simulation is

indicated with a special icon 8. As the instance runs in hardware, you cannot expand it
to see its internal signals and submodules.

g-_? I5irm (0.76) - [Default.wefg]
@File Edit View Simulation Window Layout Help

DAL $DEX® va|lfz | OO0, iALR AR
Instances and Processes + 0O &F X| Objects 08 x
mmg}mg}@ Simulation Objects for dut

0 P Y Y )
Instance and Process Name Design Unit Block Ty
Q th tb Verilog M Data Type &
Fi=) drive_sample th Verilog Tag Logic
Fix) drive_frame th Verilog Tag Logic
L, dut fp_fft_top Werilog M Logic
L_fj MetDecl_14 0 th Verilog Pro Logic
L_E| Always_91_1 th Verilog Pro Logic A
L_fj Initial_156_2 th Verilog Pro Logic 3
L_E| Always_284 3 th Verilog Pro Logic
L_fj Always_329_4 th Verilog Pro Logic
L_E| Always_358_5 th Verilog Pro Logic
L_fj Always_400_6 th Verilog Pro Logic
I gibl glbl Verilog M¢ Logic —
Logic
Logic
4| 1 [ tog?c
ogic k™
a% Instances and Processes | Memory | :3 Source Files | g ¥

Console

Before the simulation starts, ISim programs the FPGA with the bitstream file generated
for hardware co-simulation.

Notice the message in the ISim console window:

“Downloading  bitstream, please wait till status is READY”
After the FPGA is configured, the console shows:

“Bitstream download is complete. READY for simulation.”

Note If your computer has more than one ethernet port, you must identify the one to
use to the simulation process. See Determining the Ethernet Port, for more information.

Accelerating Floating Point FFT Simulation
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From this point, you can run the simulation and interact with the ISim GUI the same
way you do in the software simulation flow.

Sim (0.76) - [Defaultwefg]
[ File Edit View Simulation Window Layout Help

DE|E #DDOX®|9 | ) mE DD AN
Instances and Proc... + 00 & X | Objects 08X
Simulation Objects for :data_stimuii 2

I A P Y &

»

Instance and Process Name

0 fsretn Object Name Value Data Type ~|
@ dut [} seedr 1111101010111001.. IntType @ onfig_tdata[15:0]
(7 :dlock_gen [ seed2 1100100001000100.. Int Type ~ -
5 cdata_stimuli 15 rana 0.46255596078633¢ Float Type Q - data_tralid
(4 :contig_stimuli op_data_save.. {(11000100000011. Amay it onfig_tready
s irecord_outputs 1y ac o Logic ar data_tread
(& :check_outputs ! Logic onfig_tvalid
(679 ! Logic i -
& 680 2 Array
(& 683 | Logic )
(3 684 ! Logic T W FFTOUTPUTS
(& 686 2 Array v
& w687 ! Logic -
680 1 Logic
69t ! Logic -
693 2 Array
694 ! Logic
i ool ! Logic E
J std_logic 1164 ! Logic
J numeric_std ! Logic
) mathrea I Logic R — I
1 Logic event_status_channel_halt
P 0101610161011 Amay x _channel_halt | ]
2 +20001000:201000. Ay ot channel ot I
= e tdata_fud_inv I
1 -525.022705078137 Float Type co T " .
I eetrsrrsere T e s i 1 | 1010101010101}
2 1100011000110101_ Arrgy ;
2 0100010110110011_ Amay
1 -11601.2753306252 Flogt Type R ——
1 §741.05175781261  Float Type
1 . . on _data_tdata_im_real
1 defaule Enumeration . data_tdata,_re_real
! _data_tdata_im_real
2 (01000110101000_. Arrgy
U op_rrame 1 int Type
S . clock period 100000 ps Physical Type
- 1B ¢ roid 10000 ps Physical Type T
2 Instanc Memory 4 || « i v = Default. wefg™ 8
Console eO8x
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Appendix A

Additional Resources

e Xilinx Glossary -
http://www.xilinx.com/support/documentation/sw_manuals/glossary.pdf

¢ Xilinx Documentation - http://www.xilinx.com/support/documentation

e Xilinx Support -http://www.xilinx.com/support/documentation
o Virtex®-5 ML506 Evaluation Platform User Guide (UG347)

o Virtex®-6 ML605 Documentation

e Spartan®-6 Boards and Kits

e [Sim User Guide (UG660)

e [SE Hardware Co-Simulation Tutorials: Accelerating Floating Point FFT Simulation
(UG817)

e |SE Hardware Co-Simulation Tutorial: Interacting with Spartan-6 Memory Controller
and On-Board DDR2 Memory (UG818)

e [SE Hardware Co-Simulation Tutorial: Processing Live Ethernet Traffic Through Virtex-5
Embedded Ethernet Mac (UG819)

Accelerating Floating Point FFT Simulation
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http://www.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=en&topic=glossary
http://www.xilinx.com/support/documentation
http://www.xilinx.com/support
http://www.xilinx.com/support/documentation/boards_and_kits/ug347.pdf
http://www.xilinx.com/products/boards/ml605/reference_designs.htm
http://www.xilinx.com/products/boards_kits/spartan6.htm
http://www.xilinx.com/cgi-bin/docs/rdoc?l=en;v=13.4;t=ise+tutorials;d=ug660.pdf
http://www.xilinx.com/cgi-bin/docs/rdoc?l=en;v=13.4;t=ise+tutorials;d=ug817.pdf
http://www.xilinx.com/cgi-bin/docs/rdoc?l=en;v=13.4;t=ise+tutorials;d=ug817.pdf
http://www.xilinx.com/cgi-bin/docs/rdoc?l=en;v=13.3;t=ise+tutorials;d=ug818.pdf
http://www.xilinx.com/cgi-bin/docs/rdoc?l=en;v=13.3;t=ise+tutorials;d=ug818.pdf
http://www.xilinx.com/cgi-bin/docs/rdoc?l=en;v=13.4;t=ise+tutorials;d=ug819.pdf
http://www.xilinx.com/cgi-bin/docs/rdoc?l=en;v=13.4;t=ise+tutorials;d=ug819.pdf
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Appendix B

Determining the Ethernet Port

To run an Ethernet-based Hardware Co-Simulation when multiple Ethernet interfaces
are present, you must select the Ethernet interface that you want to co-simulate.

If you ran a previous hardware co-simulation using the Point-to-Point interface option,
you see the following error message:

"ERROR: In process wrapper AHIL_INITIALIZE

Failed to open hardware co-simulation instance.
Error in Point-to-point Ethernet Hardware Co-simulation.
There are multiple Ethernet interfaces available.

Please select an interface."

Use the following steps to determine the Ethernet port, set and verify the Ethernet
address, and verify that the simulation runs. Refer to the following figure for Step 1.

‘ CAWRMNDOWS s yntem 3 2 \omd. oxe - O] %

EOVAY « = = o = = = &= = =

roadcon HetXtre
- 19-09-75-E5-9

169 .25%4.148 .8
: 55 .0.8

1. Determine the Ethernet port to which the co-simulation board is connected.
a. Onyour system command prompt, open a command terminal window (cmd)

In the command window, type ipconfig ~ -all  to list all Ethernet ports and
connections.

c. Locate the physical address of the Ethernet port connected to the co-simulation
board.

d. Convert the physical address delimiter from a dash (-) to a colon (:). For
example: 00:19:B9:75:E5:95

Accelerating Floating Point FFT Simulation
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2. Set and verify the correct Ethernet port in ISim, as follows:

a. Open the ISim GUL

b. Select the Design under Test (DUT).
c.  Go to the Tcl console.

d.

i.  Set the Ethernet address:

hwcosim set
<## HE LA LA

In the Tcl console, enter the following commands:

ethernetinterfacelD
<physical

address>

ii. Verify the Ethernet address:
hwcosim get ethernetinterfacelD
iii. Verify that the simulation runs:

run 10us

The following figure outlines the process within the ISim GUL

Irtarces andPr. =0 & X Objects “=0 8 x
i | el Semadation Cljects for dut
d. » | R LJ gy » - - =
Instance and Process Name & 0/ | & L L )8
@ remn Chpect Name vale Data &
Fla) reverse_vedtor 3 = 1 [} Loge
W Clear_fit_sh_dy L fle_start 1 Loge
Fad load_fft_wn_dat 41; fle_wn_re{31:0] 0OL1111020021241. Amay
ety &E Me_an_m{31:0] 0000000000000000. Array
o, ot | M fwd e 2 Lo
——m B Me_fwd v v © Lo
L3 Cont_89_1 o M _rfd 1 Lt
0y Aweays_51_2 o J_" e nded .. 00001111100110 Array
D Nways 543 o 1T _busy 0 Loge
Wy Mewarys_101 4  ffe_edone L} Lo
W Cort_149.5 - L ffe_dore 0 Loge
" ey, O fe_av ] Loge
- < Gk ndes{ . 00G0B000000000 Anwy ¥
A Iatances | Source £ > fo e _thwefy £}
Coracle »D&X Frdi. »O08X C. 0D X
Caatam ULt s SRR L] —— - - -
S > restart 2. . 8 " F'_.ulm. ~
S > hwcosim set ethernetinterfacelD 00:198%75E595 - 7| ey
iSam > hwecosim get ethernetinterface 1D bt il 5 OLCompler
b0: 19:69: 756595 JNCEAS
US> run 10us WO EDfeS
hverloaluel
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